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This publication is protected by copyright, and all rights are reserved. No part of it may be reproduced or transmitted in any form or by any means for any purpose 

without express prior written consent from Electronics for Imaging, Inc., except as expressly permitted herein. Information in this document is subject to change 

without notice and does not represent a commitment on the part of Electronics for Imaging, Inc. 

The software described in this publication is furnished under license and may only be used or copied in accordance with the terms of such license. 

Patents: 5,666,436; 5,553,200; 5,543,940; 5,537,516; 5,517,334; 5,506,946;5,424,754; 5,343,311; 5,212,546; 4,941,038; 4,837,722; 4,500,919

Trademarks 

EFI, the EFI logo, Fiery, the Fiery logo, EFICOLOR, and Rip-While-Print are trademarks registered in the U.S. Patent and Trademark Office.  Fiery ZX, Fiery LX, 

Fiery X2, Fiery Driven, the Fiery Driven logo, Command WorkStation, AutoCal, Starr Compression, Memory Multiplier, ColorWise, NetWise, and VisualCal 

are trademarks of Electronics for Imaging, Inc.  

Adobe, the Adobe logo, Adobe Illustrator, PostScript, Adobe Photoshop, Adobe Separator, and Adobe PageMaker are trademarks of Adobe Systems Incorporated, 

registered in certain jurisdictions. EPS (Encapsulated PostScript) is a trademark of Altsys Corporation. Apple, the Apple logo, AppleShare, AppleTalk, EtherTalk, 

LaserWriter, and Macintosh are registered trademarks, and MultiFinder is a trademark of Apple Computer, Inc. Microsoft, MS, MS-DOS, and Windows are 

registered trademarks of Microsoft in the US and other countries. QuarkXPress is a registered trademark of Quark, Inc. Times, Helvetica, and Palatino are 

trademarks of Linotype AG and/or its subsidiaries. ITC Avant Garde, ITC Bookman, ITC Zapf Chancery, and ITC Zapf Dingbats are registered trademarks of 

International Typeface Corporation. Ethernet is a registered trademark of Xerox Corporation. Farallon, PhoneNET PC, and PhoneNET Talk are trademarks of 

Farallon Computing, Inc. COPS and COPSTalk are trademarks of CoOperative Printing Solutions, Inc. NetWare and Novell are registered trademarks and 

Internetwork Packet Exchange (IPX) is a trademark of Novell, Inc. SyQuest is a registered trademark, in the United States and certain other countries, of SyQuest 

Technology, Inc. UNIX is a registered trademark of UNIX System Laboratories, a wholly owned subsidiary of Novell, Inc. PANTONE is a registered trademark 

of Pantone, Inc. 

All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby acknowledged.

Legal Notices 

APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. 

APPLE DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE 

OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE 

RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED 

WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 

INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF 

BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE EVEN IF APPLE 

HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR 

LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 

Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort [including negligence], 

product liability or otherwise), will be limited to $50. 

Restricted Rights Legends 

For defense agencies: Restricted Rights Legend. Use, reproduction, or disclosure is subject to restrictions set forth in subparagraph (c)(1)(ii) of the Rights in 

Technical Data and Computer Software clause at 252.227.7013. 

For civilian agencies: Restricted Rights Legend. Use, reproduction, or disclosure is subject to restrictions set forth in subparagraph (a) through (d) of the 

commercial Computer Software Restricted Rights clause at 52.227-19 and the limitations set forth in Electronics for Imaging, Inc.’s standard commercial 

agreement for this software. Unpublished rights reserved under the copyright laws of the United States. 

Printed in the United States of America on recycled paper.

Part Number: 10016470 



FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 

the user’s authority to operate this equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 

designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, 

and uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference 

at his own expense. 

Industry Canada Class A Notice

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard 

entitled, “Digital Apparatus” ICES-003 from Industry Canada.

Avis de Conformation Classe A d l’Industrie Canada 

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la Classe A prescrites dans la 

norme sur le matériel brouilleur, “Appareils Numériques” NMB-003 édictée par l’Industrie Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 

advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.

Electronics for Imaging, Inc.

Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde 

das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.

Electronics for Imaging, Inc.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 

operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 

who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 

geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 

werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen 

ist der Betreiber verantwortlich.

Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 

ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 

the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 

with the Fiery ZX you have purchased, including without limitation the PostScript®  software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with Fiery ZX;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery ZX provided the transferee agrees to be bound by 

all of the terms and conditions of this Agreement.



You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 

for use other than with Fiery ZX;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 

necessary for use with the Fiery ZX unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 

any copies of that certain portion of the Software which has been included on the Fiery ZX hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 

and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 

Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 

licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 

trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 

the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font 

Programs. At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 

to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 

termination of this license and will make available to Electronics for Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 

significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 

Fiery ZX to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to correct 

or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states 

do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 

statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 

OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 

OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 

WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 

the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 

PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 

THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 

LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 

OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK. 

BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 

INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 

licenses. Your failure to comply with this provision is a material breach of this Agreement.



Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 

Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 

Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-

party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 

Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 

for Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 

Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 

at www.efi.com.

Electronics for Imaging, Inc.

2855 Campus Drive

San Mateo, CA 94403
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ix Copier and feature support

This manual describes how to install the user software for the Fiery ZX3300/ZX3200 

Color Server ™  and set up printing from Windows and Mac OS computers. For 

information about setting up network servers and clients to use the Fiery ZX Color 

Server, see the Configuration Guide. For general information on using the color copier, 

your computer, your application software, or your network, see the manuals that 

accompany those products.

NOTE: The term “Fiery ZX” is used to refer to both the Fiery ZX3300 and 

Fiery ZX3200 Color Server. Where appropriate, differences between the two are noted.

Copier and feature support

The Fiery ZX supports R2 color copiers—the term “R2” refers to the following copier 

models:

• Ricoh Aficio Color 5106 and 5206

• Lanier 5606DC

• Sharp AR-C861 and AR-C862

• Gestetner 2606 and 2606e

• nashuatec C606 and C606e

• Rex Rotary CC8606 and CC8606E

• infotec 7316 and 7316E

• Savin SDC206 and SDC206E

The Fiery ZX3300 includes Command WorkStation™  software, which enables an 

operator to manage all jobs sent to the Fiery ZX. Although it may not be the case at all 

sites, the documentation for this product assumes the presence of an operator who 

controls and manages jobs sent by users from remote workstations.

The Fiery ZX3200 does not include Command WorkStation software. However, 

Command WorkStation hardware and software are both available options; contact 

your authorized service technician for information.

I ntroduction
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Your Fiery ZX includes a media pack containing:

• User Software CD

• For the Fiery ZX3300, Command WorkStation CD

• Documentation set

• Printed Release Notes (described below)

About the documentat ion

This manual is part of the set of Fiery ZX documentation, which includes the 

following manuals for users and system administrators:

• The Configuration Guide explains basic configuration and administration of the 

Fiery ZX for the supported platforms and network environments. It also includes 

guidelines for setting up UNIX, Windows NT, and NetWare servers to provide 

PostScript printing services to clients.

• Getting Started describes how to install software to enable users to print to the 

Fiery ZX. Specifically, it describes installation of PostScript printer drivers, printer 

description files, and other software provided on the User Software CD and 

Command WorkStation CD. It also explains how to connect each user to the 

network.

• The Printing Guide describes the printing features of the Fiery ZX for users who 

send jobs via remote workstations on the network or via a direct parallel port 

connection.

• The Color Guide provides an introduction to the basics of color theory and printing 

to a Fiery ZX Color Server. It also includes practical color printing tips and 

application notes that explain how to print to the Fiery ZX from popular Windows 

and Mac OS applications.

• The Job Management Guide explains the functions of the Fiery client utilities, 

including the Command WorkStation, and how they can be used to manage jobs 

and maintain color quality. This book is intended for an operator or administrator, 

or a user with the necessary access privileges, who needs to monitor and manage job 

flow, perform color calibration, and troubleshoot problems that may arise. 

• Release Notes provide last-minute product information and workarounds for some of 

the problems you may encounter.



xi Specificat ions

Specificat ions

The Fiery ZX has the following features:

• DEC Alpha 21164, 533 MHz CPU

• For the Fiery ZX3300, 256MB RAM

For the Fiery ZX3200, 160MB RAM

You may be able to add additional memory. Contact your authorized service 

technician for information.

• Internal 4GB hard disk drive

• Internal 100MB removable cartridge Iomega Zip drive (available as an optional kit)

• Internal CD-ROM drive

• Supports AppleTalk, TCP/IP, and IPX protocols simultaneously

• Supports parallel port communication

• Supports thinnet (thin coaxial Ethernet cable or 10Base2), thicknet (thick coaxial 

Ethernet cable or 10Base5), and unshielded twisted pair (Fast Ethernet 100BaseT X 

or Ethernet 10BaseT)

• Supports Token Ring networking (available as an optional kit)

• Supports Adobe PostScript 3

• Includes 136 fonts (117 Adobe Type 1 PostScript and 19 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font 

substitution in PDF files.

• Built-in ColorWise™  color management and NetWise™  networking features

• Fiery WebTools™

• Fiery Downloader™ , Fiery Print Calibrator™ , and Fiery Spooler™  client utilities

• Fiery Scan plug-in
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User software

The full set of Fiery ZX user software is provided on the User Software CD and the 

Command WorkStation CD. The Adobe PS Printer Driver and PPD file can also be 

installed with the Installer WebTool.

Adobe PS Printer Driver Enables you to print to the Fiery ZX from Windows 

and Mac OS computers; also supports special 

Fiery ZX and PostScript 3 features.

PostScript Printer Description 

file (PPD)

File for use with the PS printer driver that allows the 

Fiery ZX to appear in popular applications’ Print 

and Page Setup dialog boxes. The Fiery ZX PPD 

provides information about the Fiery ZX and your 

particular copier model to the application and 

printer driver you are using.

PostScript Screen Fonts Screen fonts for the 136 PostScript printer fonts 

installed on the Fiery ZX (117 Adobe Type 1 and 19 

TrueType). See Appendix B of the Printing Guide 

for a complete list.

Fiery Downloader Enables you to print PostScript files, Encapsulated 

PostScript (EPS) files, and Portable Document 

Format (PDF) files directly to the Fiery ZX without 

opening the application in which they were created. 

The Fiery Downloader also enables you to manage 

the printer fonts installed on the Fiery ZX.

Fiery Downloader is also installed with the 

Command WorkStation software.

Fiery Print Calibrator Enables you to calibrate the Fiery ZX remotely from 

your computer. Proper calibration keeps color 

consistent across time.

Fiery Print Calibrator is also installed with the 

Command WorkStation software.

Fiery Spooler Enables you to view the order and priority of print 

jobs, customize printer settings for jobs, delete jobs, 

and move jobs between queues. You can also use it 

to view job accounting information.



xii i System requirements

System requirements

To install the Fiery ZX user software on a Windows or Mac OS computer, the 

computer must be equipped with a built-in or external CD-ROM drive.

Windows

To print to the Fiery ZX, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• Windows 95, Windows 3.1x, or Windows NT 4.0

• At least 4MB of RAM

To use Fiery utilities (Fiery Downloader, Fiery Print Calibrator, and Fiery Spooler) you 

also need:

• Either Windows 95 or Windows NT 4.0 with NT Service Pack 3

• At least 16MB of RAM

To use Fiery Scan, you also need Adobe Photoshop version 2.5 or later.

Fiery Scan™  Plug-in A TWAIN plug-in module for Photoshop that 

enables you to scan images from the copier directly 

into Photoshop. 

For the Fiery ZX3300, 

Command WorkStation 

software (on the Command 

WorkStation CD)

Enables you to track and manage print jobs, manage 

printer fonts, preview print jobs, merge documents, 

perform calibration, and configure the server from a 

remote workstation. For more information on the 

Command WorkStation, see the Job Management 

Guide.

Color management files ColorSync and ICM color management files that 

enable you to maintain consistent color from your 

original artwork to the colors displayed on your 

monitor to the printed output.

Color reference files Reference pages that you can print to view the range 

of colors available on your Fiery ZX.
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To use Fiery WebTools, you also need:

• Either Netscape Communicator v4.0.3 with Java enabled or Microsoft Internet 

Explorer v3.0.2 with Java enabled

NOTE: Netscape and Microsoft continue to release frequent updates to their browsers. 

As support cannot be guaranteed for all versions, use the versions specified above for 

best results.

• A monitor that supports 16-bit color at a minimum resolution of 600 x 800

• A TCP/IP enabled network and the IP address or DNS name of the Fiery ZX

• Web Services enabled on the Fiery ZX

NOTE: Fiery utilities and Fiery WebTools are not supported with Windows 3.1x.

With Microsoft Windows 95, you also need:

• IPX/SPX or TCP/IP networking protocol installed

NOTE: You must have TCP/IP networking protocol installed in order to use Fiery 

Spooler; Fiery Spooler is not supported over IPX/SPX.

• Adobe PostScript Printer Driver for Windows version 4.2 or later (version 4.2.1 is 

included with the user software)

With Microsoft Windows 3.1x, you also need:

• IPX networking protocol installed

• IPX/SPX networking software for IPX/SPX communication

• MS-DOS version 5.0 or later

• Adobe PostScript Printer Driver for Windows version 3.0 or later (version 3.0.1 is 

included with the user software)

With Microsoft Windows NT 4.0 you also need:

• TCP/IP or AppleTalk networking protocol installed

• The Windows PostScript Printer Driver that came with your Windows NT 4.0 

system software; however, some Fiery ZX printing features may not be available. For 

details, see the Printing Guide.
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Mac OS

To print to the Fiery ZX you need:

• A Mac OS-based computer

• At least 8MB of RAM

• EtherTalk installed

• Apple System software version 7.5 or later

• Adobe PostScript Printer Driver version 8.5 or later (version 8.5.1 is included with 

the user software)

To use the Fiery utilities (Fiery Downloader, Fiery Print Calibrator, and Fiery Spooler), 

you also need:

• A Power Macintosh computer

• At least 16MB of RAM

To use Fiery Scan, you also need Adobe Photoshop version 2.5 or later.

To use Fiery WebTools, you also need:

• Netscape Communicator v4.0.3 or later with Java enabled

NOTE: Netscape continues to release frequent updates to its browser. As support cannot 

be guaranteed for all versions, use the version specified above for best results.

• A TCP/IP enabled network and the IP address or DNS name of the Fiery ZX

• Web Services enabled on the Fiery ZX

UNI X ( TCP/ I P)

To print to the Fiery ZX with a UNIX workstation, you need:

• A workstation with standard TCP/IP connectivity (for example, Sun SPARCstation 

or Silicon Graphics workstation with Solaris version 2.x or SunOS version 4.1.x 

software)

• TCP/IP printing software that conforms to RFC1179 (Berkeley lpd protocol)
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Parallel port

To print to the Fiery ZX using the parallel port, you need:

• A Windows-based computer with an 80486, AMD, or Pentium processor

• At least 4MB of RAM

• The parallel cable included with the Fiery ZX

The cable has a DB-25 male connector (that connects to the computer) on one end 

and a DB-25 female connector (that connects to the Fiery ZX) on the other.

I PX ( Novell)

To use the Fiery ZX with an IPX (Novell) network, you need:

• A Novell server

• Novell NetWare software version 4.x or 3.x

• Support for Ethernet SNAP, Ethernet II, Ethernet 802.3, Ethernet 802.2, 

Token Ring SNAP, or Token Ring

Command WorkStat ion

To run the Command WorkStation application from a remote workstation, you need:

• A Windows-based computer with a 200 MHz Pentium processor

• Windows NT 4.0 with NT Service Pack 3

• TCP/IP networking protocol installed

• PCI VGA interface card

• At least 32MB of RAM

• At least 2MB of video RAM

• An 850MB IDE hard disk drive

• A 2x CD-ROM drive

• A 17" monitor that supports 16-bit color at a minimum resolution of 1024 x 768



1 I nstalling Windows software

This chapter describes installing software and setting up printing from a 

Windows-based computer running Windows 95, Windows 3.1x, or Windows NT 4.0.

The general steps for installing the Fiery ZX software are:

• Install the Adobe PostScript printer driver (Windows 95 and Windows 3.1x) or 

Windows PostScript printer driver (Windows NT 4.0) and PostScript Printer 

Description file (PPD) (for all Windows systems).

• Set up the printer driver to communicate with the Fiery ZX.

• For Windows 95 and Windows NT 4.0, install the Fiery utilities (Fiery Downloader, 

Fiery Print Calibrator, and Fiery Spooler) and Fiery Scan plug-in.

• For the designated Windows NT 4.0 workstation(s), install the Command 

WorkStation software.

• Configure the connection for Fiery Downloader, Fiery Print Calibrator, Fiery Scan, 

and the Command WorkStation.

• Configure the connection for Fiery Spooler.

• Copy additional color reference and application files from the User Software CD as 

needed.

I nstalling Windows software

The Instalrs folder on the User Software CD contains the following installer folders:

• Calib— Fiery Print Calibrator installer

• Download— Fiery Downloader installer

• PS_drvr—Adobe PostScript printer driver installer for Windows 95 or for 

Windows 3.1x, and Fiery ZX PPD file for all Windows systems

• Scan—TWAIN module installer, which enables you to use the Fiery Scan plug-in 

for Adobe Photoshop

• Spooler— Fiery Spooler installer

I nstalling 

User Software 

on a Windows 

Computer
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In addition, the User Software CD includes various color files. These files must be 

copied or installed from the CD and placed in the appropriate locations on your hard 

disk (see “Copying color files from the User Software CD” on page 44):

• ICM printer profile

• Separation Tables and a monitor settings file for use with Adobe Photoshop

• A sample calibration file

• A PostScript CMYK reference file

• A PostScript PANTONE Coated Color Reference file

• RGB color reference files for specifying colors from Microsoft Word and PowerPoint

• PostScript measurements files

The Command WorkStation software CD contains the software installer. For more 

information, see the Job Management Guide.

Downloading printer fi les with the I nstaller WebTool

Installers for the printer files can be downloaded from the Fiery ZX with the Installer 

WebTool (if the site administrator has enabled Internet access to the Fiery ZX). For 

instructions, see “Using the Installer WebTool” on page 62.

Once you download the installers, the installation process is identical to installing from 

the User Software CD.

Sett ing up the Fiery ZX as a PostScript  printer

To set up the Fiery ZX as a PostScript printer, you need a PostScript printer driver and 

the appropriate Fiery ZX PPD file.

• For Windows 95 or Windows 3.1x, install the appropriate Adobe PostScript printer 

driver, included with the Fiery ZX user software. Both drivers are capable of 

providing access to all Fiery ZX features; in addition, the Adobe PostScript printer 

driver for Windows 95 supports PostScript 3.

• For Windows NT systems, install the printer driver that came with your Windows 

system software. This driver may not support all Fiery ZX features.
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This following procedures are specific to each version of Windows.

Sett ing up PostScript  print ing with Windows 95

You can use the following procedure whether you are installing from the User Software 

CD or with installer files downloaded using the Installer WebTool.

NOTE: If you have problems setting up the Fiery ZX, install another PostScript printer 

such as the Apple LaserWriter, and then install the Fiery ZX.

TO I NSTALL THE ADOBE POSTSCRI PT PRI NTER DRI VER FOR WI NDOWS 9 5 :

1. I f  you are installing from the CD, insert  i t  into the CD-ROM drive and double-click the 

icon of  the CD.

I f  you are installing from the files you downloaded using the I nstaller WebTool, 

double-click the icon of  your hard disk drive.

2. I f  you are installing from the CD, open the English\ I nstalrs\ Ps_drvr folders.

I f  you are installing from the files you downloaded using the I nstaller WebTool, open 

the Prntdrv\ Ps_drvr folders on your hard disk.

3. Open the Win_95 folder, and double-click the Setup.exe icon.

4. Read the End User License Agreement. I f  you agree with the terms and condit ions of  

the agreement, click Accept.

You must click Accept before setup can continue. If you click Decline, you are 

prompted to either continue with setup or exit.
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5. Click Read to view the README file. When you are finished, close the README file and 

click Next.

The information in this file is not specific to your Fiery ZX. You can click Next to 

postpone reading this file and read it later.

6. I f  you are installing from the CD, you may see an I nstall Setup Program dialog box 

offering you the option to copy the setup program to your hard disk. Make your choice 

and then click Next.

Some printer files are installed to your hard disk.

7. I n the Printer Type dialog box, select  Local Printer and click Next.

This is a general installation. You can modify the attachment later, according to your 

network type.
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8. I f  you are installing from the CD, in the Directories box, open the 

English\ I nstalrs\ Ps_drvr\ Win_95 folders.

I f  you are installing from the installer fi les you downloaded with the I nstaller 

WebTool, in the Directories box, open the Prntdrv\ Ps_drvr\ Win_95 folders.

9. The Fiery ZX PPD appears in the Postscript  Printer descript ions ( PPD’s)  available box. 

Select  the Fiery ZX PPD file for your copier and click Next.

Select “Fiery ZX R2 1.0.”

10. I n the Available ports box, select  the LPT1 port  and click Next.

You will configure the port later, according to your network type.
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11. Using a maximum of 20 characters, enter a name for the Fiery ZX ( or leave the default  

name)  in the Printer Name box.

This name will be used in the Printers and queue windows.

NOTE: Entering more than 20 characters may cause printing problems with some 

network applications.

12. I f  you want the Fiery ZX to be the default  printer select  Yes; if  not , select  No.

13. Select  No to print ing the test  page and click Next.

You will print the test page after you finish configuring the printer.

The necessary files are installed to your hard disk. When installation is complete, the 

Properties dialog box appears.

14. Click OK.

You are notified that Setup is complete.

15. Click Exit .

The icon for your newly installed printer appears in the Printers window.

16. Use the instruct ions for connecting to your network type ( see “Complet ing the 

Windows 95 connection” below) .
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Complet ing the Windows 95 connection

To print from Windows 95 you need to:

• Set up network servers, if any.

• Set up the Fiery ZX to accept print jobs from your computer.

• Configure a port on each Windows 95 computer for the network or connection 

type.

Complet ing the Windows 95 parallel port  connection

Preparing a parallel port connection for Windows 95 requires specific BIOS settings 

on your computer, and specific port and printer settings for Windows 95. In addition, 

a change to one of the Fiery ZX Setup settings may be required if you choose to spool 

files to the Fiery ZX rather than print directly.

TO PREPARE THE FI ERY ZX AND YOUR COMPUTER FOR PARALLEL PORT 

PRI NTI NG:

1. Connect the Fiery ZX to the parallel port  on your computer.

For instructions, see the Configuration Guide.

2. I n Network Setup>Port  Setup>Parallel Port  Setup, set  Enable Parallel Port  to Yes.

For more information about Fiery ZX Setup, see the Configuration Guide.

3. I f  you want to spool fi les to the Fiery ZX, set  Port  Timeout in Seconds to 10.

I f  you want to print  direct ly to the Fiery ZX, set  Port  Timeout in Seconds to 5.

Setting this option to 10 seconds ensures that spooling is not interrupted due to 

timeout.

For this type of  connection: See:

Parallel page 7

IPX/SPX page 11

IPX (Novell) page 13

SMB printing page 14
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4. I n your computer’s BI OS sett ings, set  Parallel Port  Mode to ECP.

To access the BIOS settings, restart the computer and press the key indicated on your 

monitor as soon as the computer starts up. You may have to scroll through several 

screens to reach the parallel port settings. After setting the Parallel Port Mode to ECP, 

save your changed setting and exit.

TO PREPARE THE PRI NTER FOR PARALLEL PORT PRI NTI NG:

1. Click the Start  button, point  to Sett ings, and click Printers.

2. Click the Fiery ZX printer icon and choose Propert ies from the File menu.

3. Click the Details tab, and in the Print  to the following port  pop-up menu, select  

LPT 1: ( ECP Printer Port) .

NOTE: Check this selection carefully. It may read LPT 1: (Printer Port), which is not 

equivalent to LPT 1: (ECP Printer Port).

If this box does not read LPT 1: (ECP Printer Port), change the port setting now, as 

described in “To prepare the port for parallel port printing:” on page 9, and then 

return to this procedure. You may need your Windows 95 system CD.

4. I f  you changed the select ion in the Print  to the following port  pop-up menu, click 

Apply.

A Warning dialog box may appear, stating that fonts you downloaded to the previously 

selected port may be lost; click OK.

5. Click Spool Sett ings.

6. Select  either “Spool print  jobs so program finishes print ing faster” or “Print  direct ly 

to the printer”.

The selection you make depends on the action you took in step 3 on page 7:

• If you set the Port Timeout in Seconds to 10, you can select either option; however, 

spooling is faster.
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• If you set the Port Timeout in Seconds to 5, select “Print directly to the printer”.

7. Select  “Disable bi-direct ional support  for this printer” and click OK.

8. Click Apply.

You are now ready to print from your applications to the Fiery ZX with the parallel 

port. To confirm the connection, print a Windows 95 test page.

9. Click the General tab.

10. Click Print  Test  Page and click OK.

Perform the following procedure only if the LPT 1 port is not currently set to 

ECP Printer Port.

TO PREPARE THE PORT FOR PARALLEL PORT PRI NTI NG:

1. Click the Start  button, point  to Sett ings, and click Control Panel.

2. Double-click System.

The System Properties window appears.

3. Click the Device Manager tab.
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4. Double-click Ports.

5. Double-click the port  with ( LPT1)  in its name.

6. I n the ( LPT1)  Propert ies dialog box click the Driver tab and then click Change Driver.

7. Select  Show all devices.

8. From the Manufacturers list , select  “( Standard port  types) ”. From the Models list , 

select  “ECP Printer Port” ( not  Printer Port) . Click OK.
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9. Click OK in the ( LPT1)  Propert ies dialog box.

NOTE: You might need to insert the Windows 95 system CD to complete this step 

depending on whether the required files are on your hard disk.

10. When prompted to restart  the computer, click Yes.

After Windows 95 restarts, you can complete the procedure described in “To prepare 

the printer for parallel port printing:” on page 8.

Complet ing the Windows 95 I PX/ SPX or I PX ( Novell)  connection

If you are printing through a Novell server, the Novell network and file server should 

be set up before you begin. The file server should be configured with a print server and 

print connection for the Fiery ZX. For details see your NetWare documentation and 

the Configuration Guide.

You can also use Fiery Downloader to print directly to the Fiery ZX from Windows 95 

with IPX/SPX. 

TO SET UP I PX/ SPX PRI NTI NG:

1. Open the Windows 95 Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol and TCP/IP protocol are both listed in 

the Installed Network Components section.

For instructions, see your Windows 95 documentation.

NOTE: You must enable TCP/IP printing to ensure that all files required for IPX/SPX 

will be installed. You can select it and click Remove after you set up IPX/SPX if you do 

not need to use the TCP/IP protocol.
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3. Double-click the I PX/ SPX-compatible Protocol icon.

4. Click the Advanced tab.

5. I n the Property list , click Frame Type. I n the Value pop-up menu, select  the Frame 

Type that  corresponds to the one set  during Fiery ZX Network Setup.

If necessary, print the Configuration page from the Control Panel to check which 

Frame Type(s) are configured.
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NOTE: Do not select Auto. Doing so may not select the Frame Type specified on the 

Fiery ZX.

6. Click OK and close the Network Control Panel.

TO SET UP I PX ( NOVELL)  PRI NTI NG WI TH  WI NDOWS 9 5 :

1. Click the Start  button, choose Sett ings, and then choose Printers.

2. Click the Fiery ZX icon, and choose Propert ies from the File menu ( or right-click the 

icon and left -click Propert ies) .

3. Click the Details tab and click Add Port .

A list of connection options is displayed.

4. I n the Add Port  dialog box, specify the network path, or click Browse for a display of  

your network environment.

5. I f  you are using a NetWare file server, double-click the icon of  the NetWare file server 

you want to use for print ing to the Fiery ZX and click OK. 

6. Click the printer icon labeled with the NetWare print  queue you will use and click OK.



14 I nstalling User Software on a Windows Computer

7. I n the Add Port  dialog box, verify that  the network path is updated and click OK.

You are ready to print from the workstation.

Your print jobs are transmitted to the specified print queue on the Novell file server. 

The Fiery ZX polls the file server, and if jobs are present, they are transmitted to the 

Fiery ZX.

To confirm the connection, you can print a Windows 95 test page.

8. Click the General tab, and click Print  Test  Page.

9. Click OK.

Complet ing the SMB print ing connection

If you don’t have a Novell network, you can print via SMB printing (also known as 

Windows printing or WINS printing). Printing by this method allows you to print 

from your computer to a particular queue (Hold, Print, or Direct) on the Fiery ZX.

To set up printing to a second or third queue, you must install a new printer for each 

queue and repeat the procedure “To set up SMB printing:” on page 16. If you install 

more than one printer, give each a descriptive name during printer driver installation, 

such as Astro -Print or Astro -Ho ld, so you can easily identify printers.

BEFORE YOU  BEGI N:

1. Configure the Fiery ZX for SMB print ing in Network Setup>Service Setup>Windows 

Setup.

SMB printing is referred to as Windows Printing in Setup, on the Control Panel Map, 

and on the Configuration page. For more information, see the Configuration Guide.

2. Print  the Fiery ZX Configurat ion page.

You need information from the Configuration page to specify settings on your 

computer, such as the Server Name and IP address of the WINS Name Server.

3. Save any documents in open programs.

You are prompted to restart Windows after this procedure, so be sure to save any 

documents.
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TO PREPARE YOUR COMPUTER FOR SMB PRI NTI NG: 

1. Click Start , choose Sett ings, and click Control Panel.

2. Double-click the Network icon.

3. Select  TCP/ I P and click Propert ies.

4. Click the WI NS Configurat ion tab.
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5. Select  “Enable WI NS Resolut ion” and enter the TCP/ I P address of  the WI NS Name 

Server.

6. Click OK, and click OK at  the Network dialog box.

You are prompted to restart Windows. Click Yes, and when Windows restarts, 

continue with the following procedure.

TO SET UP SMB PRI NTI NG:

1. Click the Start  button, choose Sett ings, and click Printers.

2. Click the icon for the printer and choose Propert ies from the File menu.

3. Click the Details tab in the Propert ies window and click Add Port .

A list of connection options is displayed.



17 Sett ing up the Fiery ZX as a PostScript  printer

4. I n the Add Port  dialog box, click Browse to display your network environment.

5. Expand the levels to locate your printer and the queue to which you want to print .

The printer name you are browsing for is the name entered in Network Setup>Service 

Setup>Enable Windows Printing>Server Name, not the Server Name entered in Server 

Setup. Refer to the Configuration page for this information.

The amount of network traffic determines the amount of time required for the Browse 

function.

6. Select  the queue under the printer and click OK.

7. I n the Add Port  dialog box, verify that  the network path is correct  and click OK.

8. To confirm the connection, click the General tab in the Propert ies dialog box.

9. Click Print  Test  Page, and click OK.

If the test page prints successfully, you are ready to print from the computer.
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Sett ing up PostScript  print ing with Windows 3.1x

You can use the following procedure whether you are installing from the User Software 

CD or with installer files downloaded using the Installer WebTool.

TO I NSTALL THE FI ERY ZX PPD FI LE FOR WI NDOWS 3 .1 X:

1. I n the Main window, double-click the Control Panel icon.

2. Double-click the Adobe PostScript  Printers icon.

The Install PostScript Printer from PPD dialog box appears.

NOTE: If there is no Adobe PostScript Printers icon in the Control Panel window, you 

need to install the Adobe PostScript printer driver from the User Software CD. 

Proceed to the procedure “To install the Adobe PostScript printer driver for 

Windows 3.1x:” on page 18.

3. I f  you are installing from the CD, in the Drives box, select  the drive containing the CD.

I f  you are installing from the installer fi les you downloaded with the I nstaller 

WebTool, in the Drives box, select  your hard disk drive.

4. I f  you are installing from the CD, in the Directories box, double-click to open the 

English\ I nstalrs\ Ps_drvr\ Win_31 folders.

I f  you are installing from the installer fi les you downloaded with the I nstaller 

WebTool, in the Directories box, double-click to open the Prntdrv\ Ps_drvr\ Win_31 

folders.

5. Select  the Fiery ZX PPD from the Printer Descript ions available box and click I nstall.

Select “Fiery ZX R2 1.0.”

6. Click OK when you are notified that  the printer was successfully installed.

TO I NSTALL THE ADOBE POSTSCRI PT PRI NTER DRI VER FOR 

WI NDOWS 3 .1 X:

1. Exit  all applicat ions and close all windows.

2. I nsert  the User Software CD into the CD-ROM drive.
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3. I n the Windows Program Manager, choose Run from the File menu, and then click 

Browse.

4. Select  the drive containing the User Software CD and double-click to open the 

English\ I nstalrs\ Ps_drvr\ Win_31 folders.

5. Select  the Setup.exe file, and click OK.

6. Click OK in the Run dialog box.

The README.WRI dialog box appears.

7. Click Read to view the README file. When you are finished, close the README file and 

click Continue.

The necessary files are installed to your hard disk. When installation is complete, the 

PostScript Printer Driver Setup dialog box appears.

8. Click Restart  Windows. After the computer restarts, return to the procedure “To install 

the Fiery ZX PPD file for Windows 3.1x:” on page 18.

Complet ing the Windows 3.1x connection

To print from Windows 3.1x you need to:

• Configure a port on each Windows 3.1x computer for the network or connection 

type.

• Complete setup for the network type you are printing over.

• Set up the Fiery ZX to accept print jobs from your computer.

Sett ing the Fiery ZX as the default  printer with Windows 3.1x

You can specify the Fiery ZX as the default printer. Many Windows applications use 

the default printer when you choose the Print command.

TO SET THE FI ERY ZX AS THE DEFAULT PRI NTER:

1. I n the Control Panel window, double-click the Printers icon.

The Printers window appears.

2. Select  the Fiery ZX from the I nstalled Printers box.
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3. Click Set  As Default  Printer.

The Fiery ZX appears in the Default Printer area of the Printers window.

Select ing a printer port  with Windows 3.1x

When you install a printer, Windows assigns it to a default printer port. If the 

Fiery ZX is connected to your computer through a network or you want to assign it to 

a different port, you need to change the port assignment. Check with your system 

administrator about which port to use.

You can also use this procedure to enable printing with the parallel port.

TO SELECT A PRI NTER PORT:

1. I n the Control Panel window, double-click the Printers icon.

2. I n the Printers window, select  the Fiery ZX in the I nstalled Printers list  box.

3. Click Connect.

4. Connect the Fiery ZX to the same port  as your network.

For parallel printing, select the port (LPT1, LPT2, or LPT3) connected to your 

parallel cable.

To print to a file, select FILE. Printing to a file is useful if the Fiery ZX is elsewhere or 

off-site. However, if you select the FILE port, you cannot print to a printer until you 

select a network or printer port. (In some applications, you can select the FILE port 

from the Print dialog box; this is preferable for temporary use since it doesn’t require 

resetting the port in the Control Panel.)



21 Sett ing up the Fiery ZX as a PostScript  printer

5. Click OK.

The Printers window appears again, with the selected port next to the selected printer 

name in the Installed Printers list box.

6. When you are finished, click OK and then click Close. 

Sett ing up I PX ( Novell)  print ing with Windows 3.1x

TO SET UP I PX ( NOVELL)  PRI NTI NG:

1. I n the Main group of  the Windows Program Manager, double-click the Windows Setup 

icon.

2. From the Options menu, choose Change System Sett ings.

3. From the Network pop-up menu, choose Novell NetWare ( shell versions 3.26 and 

above) .

4. Click OK. When prompted, restart  Windows.

5. I n the Main group, double-click Control Panel, then double-click Printers. 

6. I n the Printers Control Panel window, select  the Fiery ZX and click Connect.
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7. Click Network.

If you are printing to a file, select FILE. Printing to a file is useful if the printer is 

elsewhere or off-site. However, if you select the FILE port, you cannot print to a 

printer until you select a network or printer port. If you select Network, the next 

window depends on the NetWare client driver version.

8. I f  the Network Printer Connections dialog box is displayed, select  the port  in the 

Printer connections box.

9. I n the Available queues list  box, select  the server and queue name that  correspond to 

the Fiery ZX.

10. Click the Capture button, then click the Close button.

The Connect dialog box is displayed with the network path to the Fiery ZX.

11. Click OK in the Connect dialog box.

The Printers window appears again, with the selected port next to the selected printer 

name in the Installed Printers list box.

12. Click Close in the Printers dialog box.

You are now ready to print to the Fiery ZX from Windows applications. When you 

select Print, jobs are routed to the print queue on the NetWare file server, and then 

transmitted to the Fiery ZX. The network administrator should verify the network 

connection by printing a test document from each networked computer that will use 

the Fiery ZX.

Sett ing up PostScript  print ing with Windows NT 4.0

To set up Windows NT 4.0 printing, install the Windows NT PostScript printer driver 

and configure printing for your network type. Fiery ZX printer files support 

Intel-based Windows NT 4.0.

Some features of the Fiery ZX may not be available when using the Windows NT 

PostScript printer driver. For details, see the Printing Guide.

You can use the following procedure whether you are installing from the User Software 

CD or with installer files downloaded using the Installer WebTool.
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TO I NSTALL THE FI ERY ZX PPD AS A LOCAL PRI NTER WI TH  THE 

WI NDOWS NT 4 .0  POSTSCRI PT PRI NTER DRI VER:

1. I f  you are installing from the CD, insert  i t  into the CD-ROM drive.

2. Click Start  in the Windows NT taskbar, choose Sett ings, and then choose Printers.

3. Double-click Add Printer.

4. To install a printer locally, select  My Computer and click Next.

“My Computer” is available if you logged in to a computer on which you have 

Administrator privileges. If it is not available, you can add a network printer. The 

procedure is similar to adding a port (see page 29).

5. Check LPT1: and click Next.

This is a general installation that works for the parallel port connection. You can add a 

network port later, according to your network type.
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6. I n the dialog box displaying lists of  manufacturers and printers, click Have Disk.

The Install from Disk dialog box prompts you for the disk.

7. I f  you are installing from the CD, type the name of  the CD-ROM drive ( for example, 

D:\ ) , and click Browse.

I f  you are installing from the installer fi les you downloaded with the I nstaller 

WebTool, type the name of  your hard disk drive ( for example, C:\ ) , and click Browse.

8. I f  you are installing from the CD, browse to the English\ I nstalrs\ Ps_drvr\ WI N_NT4x 

folder and click Open.

I f  you are installing from the installer fi les you downloaded with the I nstaller 

WebTool, browse to the Prntdrv\ Ps_drvr\ WI N_NT4x folder and click Open.

Make sure “Ntprint.inf” is selected and appears in the Look in box.

The path is copied to the Install from Disk dialog box.
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9. Verify the path is correct , and click OK.

10. I n the Printers box, select  the Fiery ZX PPD file and click Next.

Select “Fiery ZX R2 1.0.”

11. Using a maximum of 20 characters, enter a name for the Fiery ZX ( or leave the default  

name)  in the Printer name box, and choose whether you want the Fiery ZX to be your 

default  printer. Click Next.

NOTE: Entering more than 20 characters may cause printing problems with some 

network applications.
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12. I ndicate whether you want the printer installed as a shared printer. Click Next.

If you select Shared, you must also enter a Share Name for the printer (or leave the 

default name) and make selections from the list of operating systems used by client 

workstations. For information on shared printers, see the Configuration Guide.

13. Click No in the next  dialog box to postpone print ing a test  page, and click Finish.

If the Files Needed dialog box appears, it prompts you to locate the Windows NT 

PostScript driver Pscript.dll.

TO COMPLETE I NSTALLATI ON  OF THE WI NDOWS NT 4 .0  POSTSCRI PT 

PRI NTER DRI VER:

1. I f  this is the first  PostScript  printer on your system:

• Eject the User Software CD and insert the Windows NT Installation CD.

• In the text field, type the name of the CD-ROM drive (for example, D:\), and click 

Browse.

• Browse to i386 (the folder containing the PostScript driver).
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I f  you have already installed a PostScript  printer on your system:

• In the text field, type the name of the hard drive (for example, C:\), and click 

Browse.

• Browse to winnt\system32\spool\drivers\w32x86 (the folder containing the 

PostScript driver).

2. Click OK, then click OK in the Files Needed dialog box.

When installation is complete, the Printers window appears with an icon for the newly 

installed printer.

3. Complete the printer connection according to your network type.

Complet ing the Windows NT 4.0 printer connection

To print from Windows NT 4.0 you need to:

• Set up network servers, if any.

• Set up the Fiery ZX to accept print jobs from your computer.

• Configure a port on each Windows NT computer for the network or connection 

type.

Complet ing the Windows NT 4.0 parallel port  connection

The parallel port cable connects the Fiery ZX to a single computer. Once you have 

installed the Windows NT PostScript printer driver and the Fiery ZX PPD, complete 

the setup for parallel port printing.

To do this: See:

Configure the parallel connection “Completing the Windows NT 4.0 

parallel port connection” below

Configure the TCP/IP (lpr port) 

connection

“Completing the Windows NT 4.0 

TCP/IP connection” on page 28

Configure the IPX (Novell) 

connection

“Completing the Windows NT 4.0 IPX 

(Novell) connection” on page 30
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TO SET UP PARALLEL PRI NTI NG FOR WI NDOWS NT 4 .0 :

1. Click the Start  button, choose Sett ings, and then choose Printers.

2. Double-click the Fiery ZX icon and choose Propert ies from the Printer menu.

In the Ports tab, confirm that LPT1 (Local Port) is checked.

The Fiery ZX is ready to accept parallel print jobs from your computer, using the 

Windows NT PostScript printer driver and the Fiery ZX PPD.

3. Click the General tab and click Print  Test  Page.

When you select print, your files are transmitted over the parallel port connection to 

the Fiery ZX.

4. Click the Sharing tab if  you want to share the Fiery ZX with network users. Select  

Shared, and select  a share name.

Select the operating system or systems used by your network clients if you want to 

install a printer driver that those clients can download.

5. Click OK to exit  the Printer Propert ies dialog box.

Complet ing the Windows NT 4.0 TCP/ I P connection

Once you have installed the Windows NT 4.0 PostScript printer driver and the 

Fiery ZX PPD, complete the setup for the TCP/IP and lpr connection as follows:

• Prepare the Fiery ZX to accept print jobs using TCP/IP and lpr protocols. (For 

details, see the Configuration Guide.).

• Configure the workstation for the TCP/IP connection.

Before you continue, ask the system administrator for the IP address assigned to the 

Fiery ZX, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP Protocol and Microsoft TCP/IP Printing software should already be 

installed on the Windows NT workstation.
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TO SET UP TCP/ I P AND LPR PRI NTI NG FOR WI NDOWS NT 4 .0 :

1. Open the Propert ies dialog box for the Fiery ZX, and click the Ports tab.

2. Click Add Port .

The available port types are displayed.

3. Select  LPR Port  and click New Port .

If the LPR port is not listed, install the TCP/IP protocols. See the Configuration Guide 

or your Windows NT documentation.

4. Enter the I P address of  the Fiery ZX. 
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If your network uses Domain Name Services (DNS), enter the DNS name assigned to 

the Fiery ZX instead of the IP address.

5. Press Tab and type the internal name of  the Fiery ZX.

This name must be one of the following: print_ r2, ho ld_ r2. 

NOTE: This name is case-sensitive; type it exactly as shown above.

6. Click OK.

The workstation checks the address or DNS name you entered and notifies you if it 

cannot resolve the address.

7. Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You should now print a test 

page to verify the connection.

8. Click the General tab and click Print  Test  Page.

When you print, your PostScript files are transmitted over the LPR Port connection to 

the Fiery ZX.

9. Click OK to close the Printer Propert ies dialog box.

Complet ing the Windows NT 4.0 I PX ( Novell)  connection

Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling Fiery ZX print jobs. The 

file server should be configured with a print server and print connection for the 

Fiery ZX. For details, see your NetWare documentation.

• Prepare the Fiery ZX for IPX printing.

• Set up the IPX connection on the workstation.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client 

services should already be installed on the Windows NT workstation.
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TO SET UP I PX ( NOVELL)  PRI NTI NG FOR WI NDOWS NT 4 .0 :

1. Double-click Network Neighborhood.

2. Double-click NetWare or Compatible Network.

A list of NetWare servers is displayed.

3. Double-click the NetWare Tree or File Server on which the network administrator 

defined a print  connection for the Fiery ZX.

You may have to log in to the file server as a guest to see the print connections.

4. Double-click the print  connection defined for the Fiery ZX.

If the NetWare server does not have a suitable driver for the Fiery ZX you may be 

asked if you want to set up the printer on your workstation.

5. Click Yes.

The Add Printer Wizard appears.

6. Specify if  you print  from MS-DOS programs and click Next.

If you select Yes, you will need to capture a printer port before continuing.

7. I nstall the Fiery ZX PPD ( start  with step 6 on page 24) .

When installation is complete, a new printer window appears, with the name of the 

print queue on the NetWare server.
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8. Choose Propert ies from the Printer menu and click the Ports tab.

The NetWare queue you just connected to is listed and checked as a port for the 

Fiery ZX.

9. Click the General tab and click Print  Test  Page.

The Fiery ZX polls the NetWare server for print jobs in the print connection defined 

for the Fiery ZX. When you print, your PostScript files are spooled to that connection 

and transmitted over the queue “port” to the Fiery ZX.

The test page job is listed in the queue window until it is printed.

I nstalling ut i li ty, plug- in, and Command WorkStat ion 

software

The User Software CD includes software installers for three Fiery utilities and one 

Fiery plug-in. Fiery utility and plug-in software is supported with Windows 95 and 

Windows NT 4.0 only, and must be separately installed on each user’s computer.

The Command WorkStation CD includes the software installer for the Command 

WorkStation. Command WorkStation software is supported with Windows NT 4.0 

only. It should be installed only on workstations that are designated for Command 

WorkStation use.
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Fiery Downloader and Fiery Print  Calibrator

The installers for two of the Fiery utilities (Fiery Downloader and Fiery Print 

Calibrator) are the same. Before you begin each installation, determine the following:

• Where do you want to install the utility on your hard disk?

By default, the installer places the utility in a folder named “Fiery” on the top level 

of your hard disk.

• What do you want to name the utility folder in the Windows\Start Menu\Programs 

folder?

By default, the installer names the folder “Fiery.”

TO I NSTALL FI ERY DOWNLOADER AND FI ERY PRI NT CALI BRATOR:

1. On the User Software CD, browse to the English\ I nstalrs folder.

2. I f  you are installing Fiery Downloader, double-click to open the Download\ Disk1 

folders.

I f  you are installing Fiery Print  Calibrator, double-click to open the Calib\ Disk1 

folders.

3. Double-click the Setup.exe icon.

4. Follow the instruct ions in the Setup dialog boxes to complete installat ion.

I nstruct ions

Click when finished

Name of  dialog box
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Use the table below as a guide when installing Fiery Downloader and Fiery Print 

Calibrator. For specific instructions, read the information in each dialog box.

Fiery Spooler

The installer for Fiery Spooler is slightly different from the installers for Fiery 

Downloader and Fiery Print Calibrator. In addition to the Fiery Spooler utility 

software, the installer also installs Java files necessary to use Fiery Spooler. Before you 

begin this installation, determine the following:

• Where do you want to install the utility on your hard disk?

By default, the installer places the utility in a folder named “FierySpooler” on the 

top level of your hard disk.

• What do you want to name the utility folder in the Windows\Start Menu\Programs 

folder?

By default, the installer names the folder “FierySpooler.”

Name of  dialog box: Action: When finished:

Welcome Read the Setup program 

introduction.

Click Next.

Choose Destination Location Specify a hard disk location for the 

installed utility software.

Click Next.

Select Program Folder Specify a folder name for the utility 

software located in the Programs 

menu.

Click Next.

Start Copying Files Verify the information in the 

Current Settings area.

Click Next.

Information Acknowledge that the software 

installation is complete.

Click OK.
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TO I NSTALL FI ERY SPOOLER:

1. On the User Software CD, double-click to open the English\ I nstalrs\ Spooler\ Disk1 

folders.

2. Double-click the Setup.exe icon.

3. Follow the instruct ions in the Setup dialog boxes to complete installat ion of  

Fiery Spooler.

Use the table below as a guide when installing Fiery Spooler. For specific instructions, 

read the information in each dialog box.

Name of  dialog box: Action: When finished:

Welcome Read the Setup program 

introduction.

Click Next.

Choose Destination Location Specify a hard disk location for the 

installed utility software.

Click Next.

Select Program Folder Specify a folder name for the utility 

software located in the Programs 

menu.

Click Next.

Start Copying Files Verify the information in the 

Current Settings area.

Click Next.

Java (TM) Support Indicate that you want to install Java 

files onto your hard disk.

These files are necessary for using 

Fiery Spooler.

Click Yes.

Java (TM) Support Read the License Agreement. Click Yes.

Java (TM) Support Acknowledge that the installation of 

Java files is complete.

Click OK.

Java (TM) Support Indicate that you want to restart 

your computer in order to use the 

Fiery Spooler software.

Click Yes.
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Fiery Scan

The Scan folder contains the TWAIN Fiery Scan module installer. This installer 

automatically creates a folder named Twain_32 in the Windows folder on your hard 

disk, and then installs the Fiery Scan plug-in module into that folder.

You can access the Fiery Scan plug-in from Adobe Photoshop using the TWAIN 

module. For details, see the Printing Guide.

NOTE: Before installing the TWAIN Fiery Scan module, make sure the TWAIN 

plug-ins (installed with Adobe Photoshop software) are located in the correct 

Photoshop\Plugins subfolder. If the TWAIN plug-ins have been deleted, you must 

reinstall Adobe Photoshop software in order to use Fiery Scan.

TO I NSTALL THE TWAI N FI ERY SCAN  MODULE:

1. On the User Software CD, double-click to open the English\ I nstalrs\ Scan\ Disk1 folders.

2. Double-click the Setup.exe icon.

3. Follow the instruct ions in the Setup dialog boxes to complete installat ion of  the 

TWAI N Fiery Scan module.

Use the table below as a guide when installing the TWAIN Fiery Scan module. For 

specific instructions, read the information in each dialog box.

Command WorkStat ion

The Command WorkStation software installer is on the Command WorkStation CD. 

In addition to the Command WorkStation application software, the installer installs 

Java files necessary to use Fiery Setup on the Command WorkStation. Before you 

begin this installation, determine the following:

• Where do you want to install the software on your hard disk?

Name of  dialog box: Action: When finished:

Welcome Read the introduction. Click Next.

Information Acknowledge that the software 

installation is complete.

Click OK.
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By default, the installer places the Command WorkStation software in a folder 

named “Cstation” on the top level of your hard disk.

• What do you want to name the Command WorkStation folder in the 

Windows\Start Menu\Programs folder?

By default, the installer names the folder “Command WorkStation.”

• Do you want to place a shortcut to the Command WorkStation application in your 

Windows\Start Menu\Programs\StartUp folder?

Placing a shortcut in the StartUp folder automatically launches the Command 

WorkStation application every time you restart your computer.

TO I NSTALL COMMAND WORKSTATI ON  SOFTWARE:

1. On the Command WorkStat ion CD, double-click to open the English\ Disk1 folders.

2. Double-click the Setup.exe icon.

3. Follow the instruct ions in the Setup dialog boxes to complete installat ion of  Command 

WorkStat ion software.

Use the table below as a guide when installing Command WorkStation software. For 

specific instructions, read the information in each dialog box.

Name of  dialog box: Action: When finished:

Welcome Read the Setup program 

introduction.

Click Next.

Choose Destination Location Specify a hard disk location for the 

installed Command WorkStation 

software.

Click Next.

Select Program Folder Specify a folder name for the 

Command WorkStation software 

located in the Programs menu.

Click Next.

Start Copying Files Verify the information in the 

Current Settings area.

Click Next.
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Using the software for the first  t ime

Before you can use the newly installed software, you must properly configure the 

connection to the Fiery ZX.

Configuring the connection for Fiery Downloader, Fiery Print  

Calibrator, Fiery Scan, and the Command WorkStat ion

The first time you launch Fiery Downloader, Fiery Print Calibrator, Fiery Scan, or the 

Command WorkStation, you are prompted to configure the connection to the 

Fiery ZX.

NOTE: The same configuration is used when connecting to Fiery Downloader, Fiery 

Print Calibrator, Fiery Scan, and the Command WorkStation, so any change affects all 

four types of software.

Question Indicate if you want to place a 

shortcut to the Command 

WorkStation application in your 

StartUp folder.

Click Yes or No.

Java (TM) Support Indicate that you want to install Java 

files onto your hard disk.

These files are necessary for using 

Fiery Setup on the Command 

WorkStation.

Click Yes.

Java (TM) Support Read the License Agreement. Click Yes.

Java (TM) Support Acknowledge that the software 

installation is complete.

Click OK.

Java (TM) Support Indicate that you want to restart 

your computer in order to use the 

Command WorkStation software

Click Yes.

Name of  dialog box: Action: When finished:
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BEFORE YOU  BEGI N:

• I f  you are using I PX/ SPX, print  the Configurat ion page from the Control Panel and note 

the I PX address for the Fiery ZX.

In general, you should use the Ethernet IPX address. If you are connected through a 

Token Ring network, use the Token Ring IPX address.

• I f  you are using TCP/ I P, print  the Configurat ion page from the Control Panel and note 

the I P Address of  the Fiery ZX. 

You can also set up a Domain Name Server (DNS) for the IP address of the Fiery ZX 

in the printcap file and use that name. See your Windows system documentation for 

information.

TO CONFI GURE THE CONNECTI ON  FOR FI ERY DOWNLOADER,  FI ERY PRI NT 

CALI BRATOR,  FI ERY SCAN ,  AND THE COMMAND WORKSTATI ON:

1. Launch Fiery Downloader, Fiery Print  Calibrator, or the Command WorkStat ion by 

double-clicking its icon or by choosing it  f rom the Start>Programs menu.

Launch Photoshop, and open Fiery Scan ( for details, see the Print ing Guide) .

2 . Click OK.

3. Enter the appropriate information for the Fiery ZX.

Nickname—Enter a name for the Fiery ZX. This name can be any name you wish; it 

does not have to match the actual Server Name of the Fiery ZX.

NOTE: The Nickname cannot contain any of the following seven characters:

[ ] _ " ' <space> <tab>

Protocol—Choose the type of network protocol you are using from the pop-up menu.

NOTE: Command WorkStation software is supported only from Windows NT 4.0 over 

TCP/IP.
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Server Name—If you are using the TCP/IP protocol, enter the IP address (or DNS 

name) of the Fiery ZX. If you are using the IPX protocol, enter the actual Server Name 

of the Fiery ZX as it was defined during Server Setup.

I PX Address—(This area is enabled only if you choose IPX from the Protocol pop-up 

menu.) Enter the IPX Address of the Fiery ZX.

New Device—Enter the name of the device that the Fiery ZX is connected to: r2.

4. When you have entered all the information, click Add.

For TCP/ I P networks For I PX/ SPX networks
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5. With the r2 device name selected in the Devices list , click OK.

The Fiery ZX appears in the list of available servers.

6. With the r2 device name selected in the list , click OK to begin using the software.

Modifying the configurat ion

You should edit the configuration whenever there is any information change to your 

Fiery ZX server or network, such as a Server Name, IP Address/IPX Address, or device 

change. First change the specific Fiery ZX Setup information before configuring the 

connection.

TO MODI FY THE CONFI GURATI ON:

1. To edit  information for a Fiery ZX in the list  of  available servers, select  the Fiery ZX by 

its nickname and click Modify. Edit  information in the Modify Server Sett ings dialog 

box as necessary, and click OK when finished.

2. To add a new Fiery ZX to the list  of  available servers, click Add. Configure the Add New 

Server dialog box as outlined in step 3 through step 5 above.

3. To remove a Fiery ZX from the list  of  available servers, select  the Fiery ZX by its 

nickname and click Remove; then click Yes in the Remove dialog box.

Configuring the connection for Fiery Spooler

The first time you launch Fiery Spooler, you are prompted to configure a connection 

to the Fiery ZX. This configuration process is different from that for the other Fiery 

utilities.
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TO CONFI GURE THE CONNECTI ON  FOR FI ERY SPOOLER:

1. Launch Fiery Spooler by double-clicking its icon or by choosing it  f rom the 

Start \ Programs menu.

2. Click Option.

3. Click Add.

4. Enter the appropriate information for the Fiery ZX.

Name—Enter the IP address (or DNS name) of the Fiery ZX.

New Device—Enter the name of the device that the Fiery ZX is connected to: r2.
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5. When you have entered all the information, click Add.

6. With the r2 device name selected, click OK.

The Fiery ZX appears in a list of configured servers.

7. Click OK in the Configure dialog box.

The Fiery ZX appears in a list of available servers.

8. With the Fiery ZX selected in the list  of  available servers, click OK to begin using 

Fiery Spooler.

Modifying the configurat ion

You should edit the configuration whenever there is any information change to your 

Fiery ZX server or network, such as an IP Address or device change. First change the 

specific Fiery ZX Setup information before configuring the connection.
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TO MODI FY THE CONFI GURATI ON:

1. I n the Chooser dialog box, click Option.

2. To edit  information for a Fiery ZX, select  the Fiery ZX by its I P address or DNS name 

and click Modify. Edit  information in the Sett ings dialog box as necessary, and click OK 

when finished.

3. To add a new Fiery ZX, click Add. Configure the Sett ings dialog box as outlined in 

step 4 through step 6 above.

4. To remove a Fiery ZX, select  the Fiery ZX by its I P address or DNS name and click 

Remove.

5. Click OK in the Configure dialog box.

The list of available servers reflects the modifications you have made.

Copying color fi les from the User Software CD

You can copy additional color files from the User Software CD to your hard disk. 

Many of the files are PostScript files that you can download and print using 

Fiery Downloader.

The User Software CD contains the following color files:

Icm folder ICM printer profile specially designed for use with the 

Fiery ZX, your particular copier model, and the Windows 

color management system. For instructions on installing this 

profile, see “Installing the Fiery ZX ICM printer profile for 

Windows 95” on page 45.

Photoshp folder Separation Tables for use with Adobe Photoshop and the 

Fiery ZX. The Separation Tables match RGB-to-CMYK 

conversions performed in Photoshop to those performed on 

the Fiery ZX by color rendering dictionaries (CRDs).

Calrgb.ams, a monitor settings file that sets the proper source 

color space.

For instructions on installing these files, see “Installing files for 

Adobe Photoshop” on page 46.
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I nstalling the Fiery ZX I CM printer profile for Windows 95

Use the following procedure to install the Fiery ZX ICM printer profile.

NOTE: The ICM printer profile should not be installed for printing with the Microsoft 

Office 97 suite of applications. If you print from Microsoft Office 97 with the ICM 

profile installed, JPEG, BMP, and TIFF images print incorrectly.

For information on ICM profiles and color management, see the Color Guide.

Demo.mea Demo Measurement, a sample measurements file for use with 

Fiery Print Calibrator. This file is for demonstration purposes 

only and should not be used to calibrate the Fiery ZX.

Clrfiles folder 

(inside English 

folder)

Cmyk_ref.ps, an 11-page, letter-size PostScript file to use for 

reference when defining CMYK colors in applications.

PANTONE.ps, a 19-page, letter-size PostScript file that 

indicates the closest equivalent of PANTONE coated colors 

that the Fiery ZX and your particular copier model can 

produce. The method used to print the Pantone.ps file differs 

depending on the Spot Color Matching setting. For more 

information, see the Printing Guide and the Color Guide.

Rgb_01.doc, a file you can print from Microsoft Word 6.0 or 

later to view available RGB colors.

Rgb_02.ppt, a file you can print from PowerPoint 4.0 or later 

to view available RGB colors.

Patches folder

(inside Clrfiles 

folder)

Letter21.ps and Letter34.ps, which are PostScript 

measurements files. Letter21.ps is provided to enable you to 

download a page with 21 measurement patches that 

incorporate the copier’s Letter Mode; Letter34.ps is provided 

to enable you to download a page with 34 measurement 

patches that incorporate the copier’s Letter Mode. These files 

are provided for expert users and should not be used for 

day-to-day calibration.
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TO I NSTALL THE I CM PROFI LE:

1. On the User Software CD, open the I cm folder.

2. Copy the I CM profile that  corresponds to your copier to the Windows\ System\ Color 

folder on your hard disk.

Select “Efar5010.icm.”

3. I n the Color folder, right-click to select  the I CM profile.

4. Choose I nstall in Place from the menu that  appears.

The icon for the ICM profile is now white, indicating that it is installed.

I nstalling files for Adobe Photoshop

If you use Adobe Photoshop, install the Separation Tables and the Calrgb.ams monitor 

settings file for best color printing results. These files are found on the User Software 

CD in the Photoshp folder.

Loading the Separat ion Tables

The Separation Tables enable RGB-to-CMYK conversions within Photoshop that 

correspond to conversions performed by color rendering dictionaries on the Fiery ZX.

TO LOAD THE SEPARATI ON  TABLES:

1. On the User Software CD, open the Photoshp folder.

2. Copy the files “R2_p.ast” and “R2_s.ast” to your Adobe Photoshop folder.

3. Launch Photoshop.
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4. For Photoshop 4.0, f rom the File menu, choose Color Sett ings, and from the Color 

Sett ings submenu, choose Separat ion Tables.

For Photoshop 3.0, f rom the File menu, choose Preferences, and from the Preferences 

submenu, choose Separat ion Tables.

5. I n the Separat ion Tables dialog box, click Load.

6. Browse to the Adobe Photoshop folder, select  the appropriate fi le, and click Open 

( Photoshop 4.0)  or OK ( Photoshop 3.0) .

Select the <copier model>p.ast file for separating photographic RGB images to CMYK. 

Select the<copier model>s.ast file for separating solid color RGB images to CMYK.

7. Verify that  the fi le you selected appears after “Use Table:” in both places and click OK.

Separation tables remain loaded the next time you start Photoshop, unless you remove 

them.

Loading the monitor sett ings file

The Calrgb.ams monitor settings file for Photoshop defines the source color space for 

printing to the Fiery ZX and using Fiery Scan.
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TO LOAD THE MONI TOR SETTI NGS FI LE:

1. On the User Software CD, open the Photoshp folder.

2. Copy the Calrgb.ams file to your Adobe Photoshop folder.

3. Launch Photoshop.

4. For Photoshop 4.0, f rom the File menu, choose Color Sett ings, and from the Color 

Sett ings submenu, choose Monitor Setup.

For Photoshop 3.0x or Photoshop 2.5, f rom the File menu, choose Preferences, and 

from the Preferences submenu, choose Monitor Setup.

5. I n the Monitor Setup dialog box, click Load.

6. Browse to your Adobe Photoshop folder, select  the Calrgb.ams file, and click Open 

( Photoshop 4.0)  or OK ( Photoshop 3.0x or 2.5) .

The Calrgb.ams file appears as the selection in the Monitor pop-up menu of the 

Monitor Setup dialog box.

7. Under Room Parameters, set  Ambient Light  to High and click OK.
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The general steps for installing the Fiery ZX user software and setting up printing on a 

Mac OS-based computer are:

• Install the Adobe PostScript printer driver and Fiery ZX PostScript Printer 

Description file (PPD).

• Set up the Fiery ZX in the Chooser.

• Install the Fiery utilities (Fiery Downloader, Fiery Print Calibrator, and 

Fiery Spooler), and Fiery Scan plug-in.

• Install the screen fonts.

• Install the ColorSync™  profiles.

• Copy additional color-reference and application-specific files from the User Software 

CD as needed.

I nstalling Mac OS software

The Installers folder on the User Software CD contains the following installer folders:

• ColorSync™  Profiles Installer—Fiery ZX ColorSync ICC profiles installer

• Fiery Downloader—Fiery Downloader installer

• Fiery Print Calibrator—Fiery Print Calibrator installer

• Fiery Scan—Fiery Scan installer, which installs the Fiery Scan (TWAIN) plug-in and 

Fiery TWAIN plug-in

• Fiery Spooler—Fiery Spooler installer

• Printer Driver—Adobe PostScript printer driver installer and PPD file for the 

Fiery ZX

NOTE: An installer is not provided for the Mac OS screen fonts; they must be copied 

directly from the User Software CD to the System Folder:Fonts folder on your hard 

disk. For instructions, see “Screen fonts” on page 55.

I nstalling User 

Software on a 

Mac OS 

Computer
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In addition, the User Software CD contains various color files. These files must be 

copied or installed from the CD and placed in the appropriate locations on your hard 

disk (see “Copying color files from the User Software CD” on page 55).

• A PostScript CMYK color reference file

• A PostScript PANTONE Coated color reference file

• RGB color reference files for specifying colors from Microsoft Word and PowerPoint

• PostScript measurements files

• A sample calibration file

• Separation Tables and a monitor settings file for use with Adobe Photoshop

Downloading printer fi les with the I nstaller WebTool

Installers for the Fiery ZX printer files can be downloaded from the Fiery ZX with the 

Installer WebTool (if the site administrator has enabled Internet access to the 

Fiery ZX). For instructions, see “Using the Installer WebTool” on page 62.

Once you download the installers, the installation process is identical to installing from 

the User Software CD.

Sett ing up the Fiery ZX as a PostScript  printer

To set up the Fiery ZX as a PostScript printer, you must install the Adobe PostScript 

printer driver, and the PPD file that corresponds to your copier. The AdobePS printer 

driver and PPD file is provided on the User Software CD.

Printer drivers provide a way to communicate information on print jobs between your 

applications, the Fiery ZX, and any other PostScript printer connected to your 

computer.

You can use the following procedures whether you are installing from the User 

Software CD or with installer files downloaded using the Installer WebTool.
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TO I NSTALL THE ADOBEPS PRI NTER DRI VER AND PPD FI LE:

1. I f  you are installing from the CD, open the I nstallers:Printer Driver folder.

I f  you are installing from the installer fi les you downloaded with the I nstaller 

WebTool, open the Printer Driver folder on your hard disk.

2. Double-click the AdobePS I nstaller icon.

A warning dialog box appears.

3. Click Yes to continue with installat ion of  printer driver software, and to confirm that  

your computer must be restarted after installat ion.

The AdobePS Installer installs the Adobe PostScript printer driver, the PPD file that 

correspond to your copier, and the Apple Chooser.

4. Click Restart  when installat ion is complete.

NOTE: If you operate the Fiery ZX in a copy shop, quick print shop, or service bureau, 

you might want to provide copies of the printer driver, PPD file, separation tables, and 

relevant documentation to customers. This ensures that jobs they create and print to 

files are properly formatted for printing to the Fiery ZX.
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Sett ing up the Fiery ZX in the Chooser

After you install the AdobePS printer driver and PPD file (see “Setting up the Fiery ZX 

as a PostScript printer” on page 50), you need to set up the Fiery ZX in the Chooser in 

order to take full advantage of its features. This section describes how to set up the 

Fiery ZX with the AdobePS printer driver.

TO SET UP THE FI ERY ZX I N  THE CHOOSER:

1. Select  Chooser from the Apple menu.

2. Click the AdobePS icon.

Make sure AppleTalk is set to Active.

3. Select  the correct  AppleTalk Zone, i f  necessary.

4. Select  the Fiery ZX by <Server Name>_<Device Name>_<Queue Name> from the 

“Select  a PostScript  Printer” list , and click Setup.

The AdobePS printer driver automatically selects the correct PPD file for your 

Fiery ZX.

NOTE: If you enabled all three queues on the Fiery ZX (Direct, Hold, and Print), you 

will need to set up each connection separately; repeat step 4 for all enabled queues.

5. Close the Chooser.

I nstalling ColorSync, ut i li ty, and plug-in software

The Mac OS installers function essentially the same for each type of software. Before 

you begin each installation, determine where you want to install each item on your 

hard disk. By default, the installer places:

• The ColorSync Profiles in the System Folder:Preferences folder on your hard disk.

If your system uses ColorSync, you must install these profiles in a different location 

than the default location. You should install the ColorSync profiles only if your 

system uses them.

• Fiery Downloader in a folder named “Fiery” on the top level of your hard disk.

• Fiery Print Calibrator in a folder named “Fiery” on the top level of your hard disk.



53 I nstalling ColorSync, ut i li ty, and plug-in software

• Fiery Scan on the top level of your hard disk. You are prompted to locate your 

Photoshop application’s plug-ins folder.

The installer also creates a folder named TWAIN in your System Folder:Preferences 

folder, and then installs a Fiery Scan module and a Source Manager file into that 

folder. You must then install the Fiery Scan (TWAIN) plug-in module into your 

Photoshop application in order to use it.

NOTE: Before installing the Fiery TWAIN module, make sure the TWAIN plug-in 

(installed with Adobe Photoshop software) is located in the correct Photoshop\Plugins 

subfolder. If the TWAIN plug-in has been deleted, you must reinstall Adobe 

Photoshop software in order to use Fiery Scan.

• Fiery Spooler in a folder named “Fiery” on the top level of your hard disk.

NOTE: An installer is not provided for the Mac OS screen fonts; they must be copied 

directly from the User Software CD to the System Folder:Fonts folder on your hard 

disk. For instructions, see “Screen fonts” on page 55.

TO I NSTALL MAC OS SOFTWARE:

1. On the User Software CD or your hard disk, double-click to open the I nstallers folder.

2. Double-click the I nstaller icon.

I f  you are installing: Double-click:

ColorSync profiles To open the ColorSync™  Profiles Installer folder

Fiery Downloader To open the Fiery Downloader folder

Fiery Print Calibrator To open the Fiery Print Calibrator folder

Fiery Scan To open the Fiery Scan folder

Fiery Spooler To open the Fiery Spooler folder
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3. Click I nstall.

4 . Specify the locat ions into which to install each item.

Use the table below as a guide when installing software.

I f  you are installing: Action: To install:

ColorSync Profiles Browse to the System Folder:

Preferences:ColorSync™  Profiles folder.

Click Install into 

“ColorSync™  

Profiles.”

Fiery Downloader Specify a hard disk location for the installed 

Fiery Downloader software.

Click Install.

Fiery Print Calibrator Specify a hard disk location for the installed 

Fiery Print Calibrator software.

Click Install.

Fiery Scan Specify where to install the Fiery Scan 

(TWAIN) plug-in. The folder into which 

you install the plug-in depends on the 

version of Photoshop you are using.

For Photoshop 4.0, browse to the 

Photoshop:Plug-ins:Import/Export folder.

For Photoshop 3.0x, browse to the 

Photoshop:Plug-ins:Acquire/Export folder.

For Photoshop 2.5, browse to the 

Photoshop:Plug-ins folder.

Click Install into 

“(foldername).”

Fiery Spooler Specify a hard disk location for the installed 

Fiery Spooler software.

Click Install.

Software to be installed

Disk space required for 

installat ion
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5. I f  prompted, click Quit  to close the software installer.

Screen fonts

The User Software CD includes screen fonts that correspond with the 136 built-in 

PostScript printer fonts on the Fiery ZX. In order to view and use these fonts, you 

must copy them from the User Software CD to your hard disk.

TO I NSTALL SCREEN  FONTS:

1. On the User Software CD, open the Fonts folder.

2. Copy the fonts that  you want to install to the System Folder:Fonts folder on your hard 

disk.

If you have any applications open, you must quit and relaunch them before the newly 

installed screen fonts are available.

Copying color fi les from the User Software CD

You can copy additional color files from the User Software CD to your hard disk. 

Many of the files are PostScript files that you can download and print using 

Fiery Downloader.

The User Software CD contains the following color files:

Demo.mea Demo Measurement, a sample measurements file for use with 

Fiery Print Calibrator. This file is for demonstration purposes 

only and should not be used to calibrate the Fiery ZX.

Photoshop folder Separation Tables for use with Adobe Photoshop and the 

Fiery ZX. The Separation Tables match RGB-to-CMYK 

conversions performed in Photoshop to those performed on 

the Fiery ZX by color rendering dictionaries (CRDs).

Calibrated RGB, a monitor settings file that sets the proper 

source color space.

For instructions on installing these files, see “Installing files for 

Adobe Photoshop” on page 56.
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I nstalling files for Adobe Photoshop 

If you intend to use Adobe Photoshop, install the Separation Tables for best color 

printing results. These files are located on the User Software CD in the Photoshop 

folder.

Loading the Separat ion Tables

The Separation Tables enable RGB-to-CMYK conversions (in Photoshop), which 

correspond to conversions performed by color rendering dictionaries on the Fiery ZX.

TO LOAD THE SEPARATI ON  TABLES:

1. On the User Software CD, open the Photoshop folder.

2. Copy the files “Fiery R2.P” and “Fiery R2.S” to your Adobe Photoshop folder.

Color Files folder CMYK Color Reference.ps, an 11-page, letter-size PostScript 

file to use for reference when defining CMYK colors in 

applications.

PANTONE Book.ps, a 19-page, letter-size PostScript file that 

indicates the closest equivalent of PANTONE coated colors 

that the Fiery ZX and your particular copier model can 

produce. The method used to print the PANTONE Book.ps 

file differs depending on the Spot Color Matching setting. For 

more information, see the Printing Guide and the Color Guide.

RGB page 01, a file you can print from Microsoft Word 6.0 or 

later to view available RGB colors.

RGB page 02, a file you can print from PowerPoint 4.0 or later 

to view available RGB colors.

Patches folder

(inside Color 

Files folder)

Letter21.ps and Letter34.ps, which are PostScript 

measurements files. Letter21.ps is provided to enable you to 

download a page with 21 measurement patches that 

incorporate the copier’s Letter Mode; Letter34.ps is provided 

to enable you to download a page with 34 measurement 

patches that incorporate the copier’s Letter Mode. These files 

are provided for expert users and should not be used for 

day-to-day calibration.



57 Copying color fi les from the User Software CD

3. Launch Photoshop.

4. For Photoshop 4.0, f rom the File menu, choose Color Sett ings, and from the Color 

Sett ings submenu, choose Separat ion Tables.

For Photoshop 3.0x or Photoshop 2.5, f rom the File menu, choose Preferences, and 

from the Preferences submenu, choose Separat ion Tables.

5. I n the Separat ion Tables dialog box, click Load.

6. Browse to your Adobe Photoshop folder, select  the appropriate Separat ion Table fi le, 

and click Open.

Select the <copier model>.P file for separating photographic RGB images to CMYK.

Select the <copier model>.S file for separating solid color RGB images to CMYK.

7. Verify that  the fi le you selected appears after “Use Table:” in both places and click OK.

Separation tables remain loaded the next time you start Photoshop, unless you remove 

them.
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Loading the monitor sett ings file

The Calibrated RGB monitor settings file for Photoshop defines the source color space 

for printing to the Fiery ZX and using Fiery Scan.

TO LOAD THE MONI TOR SETTI NGS FI LE:

1. On the User Software CD, open the Photoshop folder.

2. Copy the Calibrated RGB file to your Adobe Photoshop folder.

3. Launch Photoshop.

4. For Photoshop 4.0, f rom the File menu, choose Color Sett ings, and from the Color 

Sett ings submenu, choose Monitor Setup.

For Photoshop 3.0x and Photoshop 2.5, f rom the File menu, choose Preferences, and 

from the Preferences submenu, choose Monitor Setup.

5. I n the Monitor Setup dialog box, click Load.
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6. Browse to your Adobe Photoshop folder, select  the Calibrated RGB file, and click Open.

The Calibrated RGB file appears as the selection in the Monitor pop-up menu of the 

Monitor Setup dialog box.

7. Under Room Parameters, set  Ambient Light  to High and click OK. 
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Fiery WebTools allow you to manage your Fiery ZX remotely from the Internet or 

from your company’s intranet. The Fiery ZX has its own home page, from which you 

are able to select from a variety of functions including Status, WebSpooler, WebLink, 

and Installer.

For more information on using Fiery WebTools, see the Printing Guide and the Job 

Management Guide.

Sett ing up Fiery WebTools

In order for network users to access and use Fiery WebTools, you need to set certain 

Fiery ZX options in Network Setup and Printer Setup. You also need to prepare each 

user’s workstation to communicate with the Fiery ZX over the Internet or intranet.

For more information about Fiery ZX Setup, see the Configuration Guide.

TO SET UP FI ERY WEBTOOLS ON  THE FI ERY ZX:

1. I n Network Setup>Port  Setup>Ethernet  Setup, set  “Enable Ethernet” to Yes.

2. I n Network Setup>Protocol Setup>TCP/ I P Setup>Ethernet  Setup, set  “Enable TCP/ I P 

for Ethernet” to Yes, and set  a valid, unique I P Address for the Fiery ZX.

3. I n Network Setup>Service Setup>Web Services Setup, set  “Enable Web Services” to 

Yes.

4. Exit  Network Setup, and select  Yes at  the Save Changes screen.

5. I n Printer Setup, set  “Publish Print  Queue” to Yes.

6. Exit  Printer Setup, and select  Yes at  the Save Changes screen.

Downloading 

I nstallers with 

Fiery WebTools
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TO SET UP FI ERY WEBTOOLS ON  EACH  USER’S WORKSTATI ON:

1. Enable TCP/ I P networking.

2. Make sure the workstat ion has a valid, unique I P address.

3. Make sure the workstat ion is installed with one of  the following I nternet  browsers:

Windows 95 and Windows NT—Either Netscape Communicator v4.0.3 or Microsoft 

Internet Explorer v3.0.2

Mac OS—Netscape Communicator v4.0.3

NOTE: Netscape and Microsoft continue to release frequent updates to their browsers. 

As support cannot be guaranteed for all versions, use the versions specified above for 

best results.

4. Make sure Java is enabled in your I nternet  browser.

For more information on setting up the Fiery ZX and your network, see the 

Configuration Guide. 

Using the I nstaller WebTool

The Installer WebTool duplicates the printer driver installers on the User Software 

CD, allowing you to easily download the current version of user software from the 

Fiery ZX to your workstation.
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TO DOWNLOAD PRI NTER DRI VER I NSTALLERS WI TH  THE 

I NSTALLER WEBTOOL:

1. Launch your I nternet  or intranet  browser and enter the DNS name or I P address of  the 

Fiery ZX.

2. Click the I nstaller button.

3. Under the name of  your operat ing system, click “Printer Files.”

For Windows computers, a dialog box appears, prompting you to save the file 

“Prntdrve.exe” to the location you choose.

For Mac OS computers, a folder named “Printer Driver” is downloaded to the desktop 

in a BinHex-encoded, compressed format. If your internet browser is equipped with an 

expander utility such as StuffIt Expander™ , the folder will be decoded and 

decompressed automatically.

4. For Windows computers, browse to the locat ion where you want to save the 

Prntdrve.exe file and click Save.

For Mac OS computers, i f  the Printer Driver folder was not automatically decoded and 

decompressed, launch a ut i li ty that  will perform that  funct ion.
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5. For Windows computers, double-click the Prntdrve.exe file, browse to the locat ion 

where you want to install the Prntdrv folder, and click Next.

The Prntdrv folder is installed to the location you specified.

6. I nstall the appropriate printer driver for your operat ing system.

For instruct ions on installing 

the printer driver for:
See:

Windows 95 “Setting up PostScript printing with Windows 95” on 

page 3

Windows 3.1x “Setting up PostScript printing with Windows 3.1x” on 

page 18

Windows NT 4.0 “Setting up PostScript printing with Windows NT 4.0” 

on page 22

Mac OS computers “Setting up the Fiery ZX as a PostScript printer” on 

page 50.
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This chapter provides troubleshooting tips.

On a Windows computer

Sett ing up I PX ( Novell)  print ing for Windows NT Workstat ion

If you have problems installing the Fiery ZX with Windows NT, try installing another 

PostScript printer (such as the Apple LaserWriter IIg), and then install the Fiery ZX. 

Installing another printer insures that all files are properly installed and available. For 

instructions, see your Windows NT documentation.

I nstalling the Adobe PostScript  Printer Driver

If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions 

and related files before installing. Search for and delete all files named Efar*.* in the 

Windows\System folder and the Windows\System\Color folder. See the Adobe 

README file included with the printer driver for more information.

Problems with the Fiery ut i li t ies on Windows 95 or Windows NT

1. I f  you are using Windows 95, make sure that  I PX/ SPX and TCP/ I P networking protocols 

are both enabled. 

See “Completing the Windows 95 IPX/SPX or IPX (Novell) connection” on page 11.

2. Make sure that  the connection is configured correct ly for your site.

To check the current configuration, launch a Fiery utility and choose Open from the 

File menu. Select the Fiery ZX and click Modify to see current settings. If the settings 

are incorrect, you can change them in this dialog box.

On a Mac OS computer

Sett ing up the Fiery ZX in the Chooser

If auto-setup does not work and you are prompted to select the PPD, select the 

appropriate Fiery ZX file in your System Folder:Extensions:Printer Descriptions folder.

Select “Fiery ZX R2 1.0.”

Troubleshooting
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I nstalling screen fonts

If you experience problems installing the PostScript screen fonts from the User 

Software CD to the System Folder:Fonts folder, try the following:

1. Quit  all applicat ions and close all windows.

2. Create a new folder and name it  “Uninstalled Fonts.”

This folder must be located outside of the System Folder.

3. Move fonts that  you are not using from the System Folder:Fonts folder to the 

Uninstalled Fonts folder.

4. Continue to copy fonts from the User Software CD to the System Folder:Fonts folder.

5. Create an alias to the System Folder:Fonts folder and to the Uninstalled Fonts folder.

6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and relaunch them in order to 

view and use the newly installed fonts.

Alternately, you can try combining fonts from multiple suitcases into a single suitcase.
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